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Раздел 1: Краткая инструкция по установке

Установка под Windows 

(Только для ОС семейства Windows)

Подготовка Mbox 2 Micro к работе с компьютером с ОС Windows включает следующие шаги:

1) “Подключение Mbox 2 Micro и установка Pro Tools LE”, стр 9.

Перед установкой ПО Pro Tools LE подключите Mbox 2 Micro к свободному порту на своем компьютере.

2) “Запуск Pro Tools LE”, стр. 11.
Ваш код авторизации находится на внутренней стороне передней обложки англоязычного руководства.

3)Настройка системы для улучшения производительности (См. “Настройка Вашей системы Pro Tools”, стр. 19).

4) Коммутация аудио в Mbox 2 Micro. (См. “Подключение к оборудованию”, стр. 33)

Установка под Mac 

(Только для систем Mac OS X)

Подготовка Mbox 2 Micro к работе с компьютером Mac включает следующие шаги:

I
1) “Установка Pro Tools LE”, стр. 15.

Перед установкой ПО Pro Tools LE подключите Mbox 2 Micro к свободному порту USB на своем компьютере.

2)“Подключение Mbox 2 Micro к компьютеру ”, стр. 16

3)“Запуск Pro Tools LE”, стр. 17.
Ваш код авторизации находится на внутренней стороне передней обложки англоязычного руководства.

4) Настройка системы для улучшения производительности (См. “Настройка Вашей системы Pro Tools”, стр. 19)..

5) Коммутация аудио в Mbox 2 Micro. (См. “Подключение к оборудованию”, стр. 33)
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Раздел 2: Знакомство с Mbox 2 Micro
Знакомьтесь с системой воспроизведения аудио Mbox ® 2 Micro от Digidesign®

Mbox 2 Micro обеспечивает компьютер с шиной USB 1/8” (3.5мм) стерео выходом, в котором используются высококачественные 24бит/48кГц ЦАП. Он также обеспечивает регулировку громкости наушников. Mbox 2 Micro предназначен для мониторинга воспроизведения в Pro Tools при редактировании и сведении

Комплектация Mbox 2 Micro
В комплект Mbox 2 Micro входит:

• USB аудиоинтерфейс Mbox 2 Micro (только воспроизведение)

• Короткий кабель USB
• Установочный диск Pro Tools, содержащий ПО Pro Tools LE™, плагины DigiRack RTAS (Real-Time AudioSuite) и AudioSuite, дополнительное ПО и электронную документацию в формате PDF 

• Регистрационная карта Digidesign 

Характеристики Mbox 2 Micro
Mbox 2 Micro предлагает следующее:

• 1/8” (3.5мм) стерео выход TRS

• Регулировку выходного уровня для наушников
• Два 1/4" (6.35 мм) разъема TRS (Tip-Ring-Sleeve).

• 24-битные ЦАП, поддерживающие частоту дискретизации 44.1 кГц и 48 кГц.

• Питание по шине USB.
• Ушко под шейный шнурок
Возможны проблемы с функционированием Mbox 2 Micro при подключении к концентратору USB. Подключайте Mbox 2 Micro к отдельному порту USB 

Mbox 2 Micro не обеспечивает внешнего входа, это исключительно устройство вывода. Соответственно, вы мне можете записывать при помощи Mbox 2 Micro внешние источники.

Хотя Mbox 2 Micro не позволяет вести запись с внешнего источника, вы можете записывать через шину Pro Tools LE (например, записывать аудиовыход инструментального плагина в аудиотрек).
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Возможности Pro Tools LE 

Pro Tools LE на платформах Windows и Mac при использовании совместно Mbox 2 Micro предоставляет следующие возможности:

• Воспроизведение до 32 моно (или 16 стерео) цифровых аудио треков или запись и воспроизведение цифровых аудиотреков общим количеством до 32 моно (или 16 стерео) в зависимости от производительности вашего компьютера. 

• Емкость сессии: до 128 аудиотреков (максимум 32 трека одновременного воспроизведения), 128 треков Aux, 64 трека мастер фейдера, 256 треков MIDI и 32 инструментальных трека

• 16-битный или 24-битный формат аудио с частотой дискретизации до 48 кГц

• Неразрушительное редактирование с произвольным доступом и автоматизация микса

• Обработка аудио с использованием до 5 плагинов RTAS на трек, в зависимости от производительности вашего компьютера

• До 5 инсертов на трек

• До 10 посылов на трек

• Дл 32 внутренних шин сведения

Pro Tools LE использует ресурсы процессора для микширования и обработки аудиотреков (программная обработка). Компьютеры с большей тактовой частотой имеют больший предел одновременно используемого количества треков и плагинов.

Требования к системе 

Mbox 2 Micro должен использоваться с соответствующим требованиям Digidesign компьютером на платформе Windows или Mac с установленным ПО Pro Tools LE 

Для установки Pro Tools с установочного диска требуется привод DVD.

Полный список требований к системе приведен на сайте Digidesign (www.digidesign.com).

Информация о совместимости

Digidesign может гарантировать совместимость и обеспечить поддержку только тех аппаратных и программных конфигураций, которые были протестированы и сертифицированы.

Актуальный список сертифицированных Digidesign компьютеров, ОС, жестких дисков и устройств третьих производителей приведен на сайте Digidesign (www.digidesign.com).

.

.

Требования MIDI

MIDI-интерфейсы с подключением по USB эффективно работают с системами Pro Tools на платформах Windows и Mac. MIDI-интерфейсы с подключением к последовательному порту поддерживаются только для платформы Windows
Только MIDI-интерфейсы с подключением по USB совместимы с системами Pro Tools на платформе Mac OS X.

Адаптеры с последовательного на параллельный порт и MIDI устройства с подключением через последовательный порт не поддерживаются.
Список поддерживаемых устройств приведен на сайте Digidesign (www.digidesign.com).
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Требования к жесткому диску

Для оптимального воспроизведения и записи звука всем системам Pro Tools требуется один или более жесткий диск, сертифицированный Digidesign. Список сертифицированных Digidesign жестких дисков приведен на сайте Digidesign (www.digidesign.com).

Если вы используете жесткий диск с шиной ATA/IDE или FireWire, инициализируйте ваш диск при помощи утилит Windows Disk Management (Windows) или Disk Utility (Mac).
За дополнительной информацией обращайтесь к Приложению С “Конфигурация и эксплуатация жесткого диска”.

Избегайте записи на системный диск.

Запись на системный диск не рекомендуется.

Запись и воспроизведение с системного диска может привести к уменьшению количества доступных к использованию треков и плагинов.
Digidesign не рекомендует вести запись на системный диск. Записывайте на системный диск только в случае необходимости.

Регистрация Digidesign

Прочитайте информацию на прилагаемой карточке регистрации Digidesign и следуйте изложенным в ней инструкциям, чтобы оперативно зарегистрировать свою покупку через интеренет. Регистрация покупки – единственный способ получить право на сопутствующую техническую поддержку и предложения апгрейда системы. Это один из наиболее важных первых шагов пользователя

.

Документация Pro Tools

Это руководство пользователя объясняет, как установить ПО Pro Tools LE, произвести коммутацию вашего интерфейса Mbox 2 Micro и выполнять основные задачи (например, запись Pro Tools).

Помимо всех печатных руководств и документации, входящих в комплект вашей системы, вместе с Pro Tools автоматически устанавливаются руководства Pro Tools в формате PDF и файлы «Read Me».
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Ключевые руководства (такие как «Pro Tools Reference Guide» и «Pro Tools Menus Guide») доступны через меню «Help» Pro Tools

• «Pro Tools Reference Guide» детально объясняет ПО Pro Tools

• «Pro Tools Menus Guide» описывает все экранные меню Pro Tools

• «DigiRack Plug-Ins Guide» объясняет как использовать плагины RTAS и AudioSuite, входящие в пакет Pro Tools.

• «Digidesign Plug-Ins Guide» объясняет, как использовать дополнительные плагины «Digidesign»

• «Pro Tools Shortcuts» содержит список «горячих клавиш» и функций правой кнопки мыши в Pro Tools.

Эти и другие руководства помещаются во время инсталляции на исходный жесткий диск. Чтобы просмотреть или распечатать руководства в формате PDF, вы можете использовать Adobe Reader
или Apple Preview (только Mac).
Печатные копии «Pro Tools Reference Guide» и других руководств Pro Tools могут быть заказаны отдельно через Интернет-магазин DigiStore (www.digidesign.com).
Система обозначений в руководстве
Руководства Digidesign используют следующую систему обозначения для пунктов меню и ключевых команд

	Обозначение
	Действие

	File > Save
	Выберите пункт « Save» в меню «File»

	Control+N
	Удерживая клавишу «Control» нажмите клавишу «N»

	Control-click
	Удерживая клавишу «Control» нажмите кнопку мыши

	Right-click
	Нажмите правую кнопку мыши


Следующие символы используются для обозначения важной информации:

Подсказка: полезные указания о том, как наиболее эффективно использовать вашу систему Pro Tools.

Важное замечание: содержит информацию, от которой зависит ваш материал или производительность системы
Горячая команда: Быстрый доступ к командам через клавиатуру или мышь.

Ссылка: Указывает на соответствующие теме разделы этого и других руководств Digidesign.
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О www.digidesign.com

Сайт Digidesign (www.digidesign.com) – это лучший для вас источник информации, которая поможет вам добиться наибольших результатов от любых систем Pro Tools. Ниже приводятся только некоторые из доступных сервисов и возможностей.

Регистрация. Зарегистрируйте свою покупку через Интернет. Инструкции приводятся в прилагаемой регистрационной карточке Digidesign.

Поддержка. Обращайтесь в службу технической поддержки Digidesign или службу работы с клиентами; скачивайте обновления ПО и последние электронные версии руководств; изучайте документацию по совместимости и требования к системе; просматривайте он-лайн базу знаний; присоединяйтесь к мировому сообществу пользователей Pro Tools через конференцию пользователей Digidesign
Обучение и образование. Станьте сертифицированным Оператором или Экспертом Pro Tools; пройдите индивидуальные Интернет-курсы или узнайте как можно пройти очное обучение в сретифицированном центре обучения Pro Tools.

Продукты и разработчики. Узнайте о продуктах Digidesign; загружайте демо-версии ПО; узнайте о наших партнерах по разработке их плагинах, приложениях и оборудовании.

Новости и события. Узнайте последние новости Digidesign; подпишитесь на демо-программу Pro Tools.

Чтобы узнать больше об этих и других ресурсах, посетите сайт Digidesign (www.digidesign.com).
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Раздел 3 Конфигурация Windows
Этот раздел содержит информацию только для систем Windows. Если вы устанавливаете Pro Tools на платформе Mac, обратитесь к Разделу 4 “Конфигурация Mac”.

Перед установкой этой версии Pro Tools ознакомьтесь с информацией в файле Read Me на установочном диске Pro Tools. 

Ход установки
Установка Mbox 2 Micro на платформе Windows включает в себя следующие шаги

Подготовка Mbox 2 Micro к работе с компьютером с ОС Windows включает следующие шаги:

1 “Подключение Mbox 2 Micro и установка Pro Tools LE”, стр 9.

2 “Запуск Pro Tools LE”, стр. 11.

3 Настройка системы для улучшения производительности (См. Раздел 5 “Настройка Вашей системы Pro Tools”, стр. 19).

4  Коммутация аудио в Mbox 2 Micro. (См. Раздел 7 “Подключение к оборудованию”)

Подключение Mbox 2 Micro и установка Pro Tools LE
Чтобы установить Pro Tools LE и Mbox 2 Micro:

1 Запустите Windows, войдя с полномочиями Администратора. Подробно о полномочиях Администратора написано в документации Windows.

1 Снимите с Mbox 2 Micro пылезащитный колпачок.

2 Подключите разъём USB Mbox 2 Micro к свободному USB порту компьютера

Дождитесь появления диалогового окна мастера «Найдено новое оборудование» и оставьте его открытым: не нажимайте кнопку «Далее». Если мастер начнет автоматическую установку драйверов, нажмите «Отмена».
В процессе установки следует игнорировать все диалоги «Найдено новое оборудование». Не нажимайте «Далее». 

При подключении к концентратору USB возможны сбои в работе Mbox 2 Micro. Подключайте Mbox 2 Micro к отдельному порту USB на компьютере.

4 Вставьте установочный диск Pro Tools LE для Windows в привод CD/DVD
5 Найдите и откройте на установочном диске папку Pro Tools Installer.

6 Двойным щелчком выберите иконку «Setup».
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7 Следуйте инструкциям, отображаемым на экране в процессе установки
8 Выберите место установки. Для максимальной надежности, установите Pro Tools на своем загрузочном диске.

9 Нажмите кнопку «Next».

10 Выберите приложение Pro Tools для установки.

11 Вы также можете выбрать дополнительные утилиты из списка для установки вместе с Pro Tools.

Поддержка дисков Mac HFS+. Эта опция дает возможность вашей системе Pro Tools осуществлять чтение, воспроизведение и запись с дисками формата Mac HFS+. Диски HFS+ обычно называют расширенными дисками Mac OS.

DigiTranslator DigiTranslator™ - программная опция для Pro Tools, которая дает вам возможность осуществлять конвертацию и обмен данными секвенций OMF и AAF и файлов MXF непосредственно в Pro Tools. Эта опция приобретается отдельно.

Драйвер контроллера Command|8. Драйвер Command|8 необходим, если вы используете аппаратный контроллер Digidesign Command|8.

Экспорт MP3. Опция экспорта MP3 дает вам возможность экспортировать файлы MP3 из сессий Pro Tools. Эта опция приобретается отдельно.

Установочный диск Pro Tools Installer содержит дополнительное программное обеспечение для вашей системы. Информация об этом содержится в параграфе «Дополнительное ПО на установочном диске Pro Tools» на стр. 11.
12 Нажмите «Next».

13 Нажмите «Install».

ОС Windows XP может выдавать в процессе установки несколько сообщений, которые можно проигнорировать, в частности, несколько диалогов “Найдено новое оборудование” и “Обнаружена проблема во время установки оборудования»

Если появится предупреждение о том, что драйвер не сертифицирован для Windows, нажмите 

«Все равно продолжать».

На Windows Vista, eсли появится предупреждение о драйвере, нажмите  «Все равно установить этот драйвер».

14 Перед тем, как перейти к следующему шагу, дождитесь, пока программа установки закончит установку всех программных компонентов, драйверов и системных файлов PACE.

15 По завершении установки нажмите «Finish».

Если после установки индикатор активности USB на передней панели Mbox 2 Micro не светится, попробуйте отсоединить кабель USB от порта USB Mbox 2 Micro и снова подсоедините его. Если индикатор USB по-прежнему не светится, выключите компьютер, отсоедините Mbox 2 Micro и снова включите компьютер. После того, как компьютер полностью перезапустится, снова подключите Mbox 2 Micro.

Если в Pro Tools  задан неправильный выход, индикатор USB LED на Mbox 2 Micro мигает желтым
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Установка QuickTime
Pro Tools требуется QuickTime, если вы планируете включать в сессию видео файлы, или импортировать файлы MP3 или MP4 (AAC). QuickTime для Windows XP можно бесплатно загрузить с сайта Apple (www.apple.com).

Информация о том, какая версия QuickTime совместима с вашей версией Pro Tools содержится в списке совместимости на сайте Digidesign (www.digidesign.com).

Чтобы установить QuickTime:

1 Зайдите на сайт www.apple.com и перейдите на страницу QuickTime 

2 Загрузите на свой компьютер программу установки QuickTime.

3 Двойным щелчком запустите установщик QuickTime и следуйте появляющимся на экране инструкциям установки.

4 Перезагрузите компьютер.

Установочный диск Pro Tools Installer содержит дополнительное программное обеспечение для вашей системы. Информация об этом содержится в параграфе «Дополнительное ПО на установочном диске Pro Tools» на стр. 17.
Отключение экранной заставки

(Только Windows Vista)

Чтобы избежать ошибок во время записи и воспроизведения сессий Pro Tools, вы должны отключить экранную заставку Windows Vista.

Отключение экранной заставки Windows Vista:
1 Щелкните правой кнопкой на рабочем столе.

2 Выберите «Настройки».

3 Выберите «Экранная заставка»

4 Установите «Нет»
5 Щелкните «Применить».

Запуск Pro Tools LE
При первом запуске Pro Tools LE от вас потребуется ввести код авторизации.

Чтобы авторизировать свою копию Pro Tools LE:

1 Убедитесь, что Mbox 2 Micro подключен к вашему компьютеру и на него подается питание.

2 Дважды щелкните на иконке Pro Tools LE на своем рабочем столе (или на иконке приложения в папке Pro Tools, вложенной в папку Digidesign.

3 Введите код авторизации в диалоговом окне (убедитесь, что набираете его точно так же, как он напечатан, проверяя пробелы и использование заглавных букв), затем нажмите кнопку «Validate».

Ваш код авторизации находится на внутренней стороне обложки англоязычного руководства.

Дополнительное ПО на установочном диске Pro Tools
Установочный диск Pro Tools содержит дополнительное ПО для вашей системы, включая аудио драйверы (для обеспечения работы других аудио приложений с вашим оборудованием Digidesign) и демонстрационную сессию Pro Tools.

Дополнительное ПО и программы установки содержатся на установочном диске Pro Tools.
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Аудиодрайверы Windows
Драйверы Digidesign ASIO Driver и WaveDriver Windows System Audio Driver позволяют использовать ваш аппаратный интерфейс Digidesign с приложениями сторонних разработчиков, которые поддерживают драйверы ASIO или WaveDriver MME (Multimedia Extension).

Драйверы Digidesign ASIO Driver и WaveDriver для вашего оборудования Digidesign автоматически устанавливаются вместе с Pro Tools.

Digidesign ASIO Driver
Драйвер Digidesign ASIO (Audio Stream Input/Output) Driver – многоканальный драйвер с поддержкой одного клиента, который позволяет программам сторонних разработчиков, поддерживающих стандарт ASIO осуществлять запись и воспроизведение через оборудование Digidesign 

Подробная информация о настройке драйвера Digidesign ASIO Driver содержится в руководстве «Windows Audio Drivers Guide».

Digidesign WaveDriver 

(Только для Windows XP)

Драйвер Digidesign WaveDriver Windows System

Audio Driver стереодрайвер с поддержкой одного клиента, который позволяет программам сторонних разработчиков, поддерживающих стандарт WaveDriver MME (Multimedia Extension) осуществлять запись и воспроизведение через оборудование Digidesign 

Подробная информация о настройке драйвера Digidesign WaveDriver содержится в руководстве «Windows Audio Drivers Guide».

Отдельные драйверы Digidesign Windows Audio
Драйверы Digidesign Windows Audio могут быть установлены и на системы, на которых не установлено ПО Pro Tools. В этом случае используйте версию для независимой установки драйверов Digidesign Windows Audio Drivers (Digidesign Audio Drivers Setup.exe), находящуюся на установочном диске Pro Tools.

Информация о настройке независимо устанавливаемых драйверов Digidesign Windows Audio содержится в руководстве «Windows Audio Drivers Guide».

Демонстрационная сессия Pro Tools
Установочный диск Pro Tools LE содержит демонстрационную сессию, которую можно использовать для проверки работоспособности системы.
Демо-сессия для Pro Tools LE называется “Filtered Dreams”.

Перед тем как установить демо-сессию на свой диск для аудио, убедитесь, что диск настроен так, как описано в параграфе «Форматирование аудио диска», стр. 54
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Чтобы установить демо-сессию:

1 Вставьте установочный диск Pro Tools LE в привод DVD.

2 Найдите и откройте на диске DVD папку Additional Files/Pro Tools LE Demo Session Installer.

3 Двойным щелчком запустите Setup.exe.

4 Следуйте инструкциям на экране
5 Выберите в качестве места установки свой диск для аудио и нажмите «Install».

6 По завершении инсталляции нажмите «OK».

Демо-сессия может быть открыта двойным щелчком на файле Filtered Dream.ptf (расположенном в папке Filtered Dream Demo Session).

Шаблоны сессии Pro Tools 

Инсталляционный диск Pro Tools LE содержит готовые шаблоны сессий, в которых заранее настроены распространенные конфигурации треков и микшеров. Используя эти шаблоны, вы можете избавиться от необходимости создания конфигурации студии с нуля всякий раз, когда вы начинаете новую сессию

Информация об использовании и настройке шаблонов сессий содержится в “Pro Tools Reference Guide”.

Чтобы установить шаблоны сессий:

1 Вставьте установочный диск Pro Tools в привод DVD.

2 На диске DVD найдите и откройте папку Additional Files/LE Session Templates Installer 

3 Двойным щелчком запустите LE Session Templates Setup.exe.

4 Следуйте инструкциям на экране.

5 При запросе выберите свой диск для аудио в качестве места установки и нажмите «Next», чтобы начать установку.

6 По завершении установки нажмите «Finish».

[Стр. 14]
Удаление Pro Tools

Если вам требуется удалить ПО Pro Tools со своего компьютера, вы можете использовать команды Windows для удаления программ.

Чтобы удалить Pro Tools со своего компьютера (Windows Vista):

1 Войдите в меню Пуск > Панель управления.

2 В пункте Программы нажмите “Удаление программы”

3 Выберите Pro Tools.

4 Нажмите «Удалить».

5 Чтобы удалить Pro Tools следуйте инструкциям на экране.

Чтобы удалить Pro Tools со своего компьютера (Windows XP):

1 Войдите в меню Пуск > Настройка > Панель управления.

2 Двойным щелчком выберите “Установка и удаление программ”.

3 В списке «Установленные программы» выберите Digidesign Pro Tools.

4 Нажмите кнопку «Удалить»

5 Чтобы удалить Pro Tools следуйте инструкциям на экране.
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Раздел 4 Конфигурация Mac 

Этот раздел содержит информацию только для систем Mac. Если вы устанавливаете Pro Tools на платформе Windows, обратитесь к Разделу 3 “Конфигурация Windows”.

Перед установкой этой версии Pro Tools ознакомьтесь с информацией в файле Read Me на установочном диске Pro Tools. 

Ход установки

Установка Mbox 2 Micro на платформе Mac включает в себя следующие шаги:

1 “Установка Pro Tools LE ”, стр. 15.

2 “Подключение Mbox 2 Micro к компьютеру ”, стр 16.

3 “Запуск Pro Tools LE”, стр 17.

4  Настройка системы для улучшения производительности (См. Раздел 5 “Настройка вашей системы Pro Tools”,).

5 Коммутация аудио в Mbox 2 Micro. (см. Раздел 7, “Подключение оборудования»)

Установка Pro Tools LE
После того, как программные настройки ОС Apple проведены, можно приступить к инсталляции Pro Tools LE.

Чтобы установить Pro Tools LE для Mac OS X:

1 Убедитесь, что учетная запись, под которой вы устанавливаете Pro Tools, имеет полномочия Администратора. Подробно о полномочиях Администратора написано в документации Apple Mac OS 
2 Вставьте установочный диск Pro Tools LE в привод CD/DVD
3 Найдите на установочном диске и запустите двойным щелчком “Install Pro Tools.”

4 Следуйте инструкциям, отображаемым на экране в процессе установки.

5 Выберите место установки. Для максимальной надежности, установите Pro Tools на своем загрузочном диске.

6 Нажмите «Continue».

7 Выберите приложение Pro Tools для установки.
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8 Вы также можете выбрать дополнительные утилиты из списка для установки вместе с Pro Tools.

DigiTranslator DigiTranslator™ - программная опция для Pro Tools, которая дает вам возможность осуществлять конвертацию и обмен данными секвенций OMF и AAF и файлов MXF непосредственно в Pro Tools. Эта опция приобретается отдельно.

MIDI I/O Driver Драйвер MIDI I/O Driver требуется, если вы используете интерфейс Digidesign MIDI I/O.

Экспорт MP3. Опция экспорта MP3 дает вам возможность экспортировать файлы MP3 из сессий Pro Tools. Эта опция приобретается отдельно.

Установочный диск Pro Tools Installer содержит дополнительное программное обеспечение для вашей системы. Информация об этом содержится в параграфе «Дополнительное ПО на установочном диске Pro Tools» на стр. 17.
9 Нажмите «Install».
10 Если будет запрошен ваш пароль Администратора введите его, и нажмите OK, чтобы подтвердить правомочность установки.

11 Следуйте остальным инструкциям на экране.

12 По завершении инсталляции нажмите «Restart».

Подключение Mbox 2 Micro к компьютеру

Перед запуском Pro Tools LE подключите к своему компьютеру Mbox 2 Micro.

Чтобы подключить Mbox 2 Micro к своему компьютеру:

1 Снимите с Mbox 2 Micro пылезащитный колпачок.

2 Подключите разъём USB Mbox 2 Micro к свободному USB порту компьютера

После того, как светодиодный индикатор активности USB станет зелёным - Mbox 2 Micro готов к работе 
При подключении к концентратору USB возможны сбои в работе Mbox 2 Micro. Подключайте Mbox 2 Micro к отдельному порту USB на компьютере.

Если после установки индикатор активности USB на Mbox 2 Micro не светится или мигает, попробуйте отсоединить кабель USB от порта USB Mbox 2 Micro и снова подсоедините его. Если индикатор USB по-прежнему не светится, выключите компьютер, отсоедините Mbox 2 Micro и снова включите компьютер. После того, как компьютер полностью перезапустится, снова подключите Mbox 2 Micro.
Если в Pro Tools  задан неправильный выход, индикатор USB LED на Mbox 2 Micro мигает желтым
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Запуск Pro Tools LE
При первом запуске Pro Tools LE от вас потребуется ввести код авторизации 

Чтобы авторизировать свою копию Pro Tools LE:

1 Убедитесь, что Mbox 2 Miсro подключен к вашему компьютеру и на него подается питание.

2 Дважды щелкните на иконке Pro Tools LE на своем рабочем столе (или на иконке приложения в папке Pro Tools, вложенной в папку Digidesign.

3 Введите код авторизации в диалоговом окне (убедитесь, что набираете его точно так же, как он напечатан, проверяя пробелы и использование заглавных букв), затем нажмите кнопку «Validate».

Ваш код авторизации находится на внутренней стороне обложки англоязычного руководства.

Ваш код авторизации находится на внутренней стороне передней обложки англоязычного руководства.

Дополнительное ПО на установочном диске Pro Tools
Установочный диск Pro Tools содержит дополнительное ПО для вашей системы, включая аудио драйверы (для обеспечения работы других аудио приложений с вашим оборудованием Digidesign) и демонстрационную сессию Pro Tools.

Дополнительное ПО и программы установки содержатся на установочном диске Pro Tools.

Драйвер Mbox 2 Micro CoreAudio
Mbox 2 Micro CoreAudio – многоканальный, многоклиентный драйвер, который позволяет совместимым с CoreAudio приложениям осуществлять запись и воспроизведение через оборудование Digidesign.

Драйвер Mbox 2 Micro CoreAudio автоматически устанавливается вместе с Pro Tools.

Подробная информация о настройке драйвера Mbox 2 Micro CoreAudio содержится в руководстве «CoreAudio Drivers Guide»
Отдельный драйвер Mbox 2 Micro CoreAudio Driver
Драйвер Mbox 2 Micro CoreAudio может быть установлен и на системы, на которых не установлено ПО Pro Tools. В этом случае используйте версию для независимой установки, находящуюся на установочном диске Pro Tools (в папке Additional Files Folder). 

Информация об инсталляции и настройке независимо устанавливаемого Mbox 2Micro CoreAudio драйвера содержится в руководстве «CoreAudio Drivers Guide»

Демонстрационная сессия Pro Tools
Установочный диск Pro Tools LE содержит демонстрационную сессию, которую можно использовать для проверки работоспособности системы.

Демо-сессия для Pro Tools LE называется “Filtered Dreams”.

Перед тем как установить демо-сессию на свой диск для аудио, убедитесь, что диск настроен так, как описано в параграфе «Форматирование аудио диска», стр. 60
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Чтобы установить демо-сессию:

1 Вставьте установочный диск Pro Tools LE в привод DVD.

2 Найдите и откройте на диске DVD папку Additional Files/Pro Tools LE Demo Session Installer.

3 Двойным щелчком запустите Setup.exe.

4 Следуйте инструкциям на экране
5 Выберите в качестве места установки свой диск для аудио и нажмите «Next», чтобы начать инсталляцию.

6 По завершении инсталляции нажмите «OK».

Демо-сессия может быть открыта двойным щелчком на файле Filtered Dream.ptf (расположенном в папке Filtered Dream Demo Session).

Шаблоны сессий Pro Tools 

Инсталляционный диск Pro Tools LE содержит фабричные шаблоны сессий, которые заранее настроенные на распространенные конфигурации треков и микшеров. Используя эти шаблоны, вы можете избавиться от необходимости создания конфигурации студии с нуля всякий раз, когда вы начинаете новую сессию

Информация об использовании и настройке шаблонов сессий содержится в “Pro Tools Reference Guide”.

Чтобы установить фабричные шаблоны сессий:

1 Вставьте установочный диск Pro Tools в привод DVD.

2 На диске DVD найдите и откройте папку Additional Files/LE Session Templates Installer 

3 Двойным щелчком запустите LE Session Templates Setup.exe.

4 Следуйте инструкциям на экране.

5 При запросе выберите свой диск для аудио в качестве места установки и нажмите «Next», чтобы начать установку.

6 По завершении установки нажмите «Close».
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Удаление Pro Tools

Если вам нужно удалить ПО Pro Tools со своего компьютера, используйте приложение Uninstaller.

Чтобы удалить Pro Tools со своего компьютера:

1 Убедитесь, что под учетной записью, где установлена система Pro Tools, вы вошли как администратор.

Подробно о полномочиях администратора в Mac OS X см. документацию Apple OS X.
2 Откройте Applications/Digidesign/Pro Tools/Pro Tools Utilities и двойным щелчком откройте файл “Uninstall Pro Tools”.

3 Нажмите «Continue», чтобы продолжить удаление.

4 Выберите тип удаления, который вы хотите произвести:

Safe Uninstall Оставляет определенные плагины и системные файлы, необходимые для совместимости с некоторыми продуктами Avid.

Clean Uninstall Удаляет все файлы Pro Tools, включая системные файлы, плагины Digidesign и имена патчей MIDI.

5 Нажмите «Uninstall».

6 Введите свой пароль администратора и нажмите «ОК».

7 Нажмите «Finish», чтобы закрыть окно “Uninstaller».
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Раздел 5. Настройка системы Pro Tools
После подключения системы и установки ПО Pro Tools вы готовы, чтобы включить и настроить свою систему Pro Tools.

Включение и выключение вашей системы
Чтобы убедиться, что компоненты вашей системы Pro Tools корректно взаимодействуют друг с другом, вы должны включать их в определенном порядке.

Запускайте свою систему Pro Tools в следующем порядке:

1 Уберите громкость всех выходных устройств вашей системы.

2 Включите все внешние жесткие диски. Подождите примерно десять секунд, пока они войдут в рабочий режим.

3 Включите все консоли управления (такие как Command|8).

4 Включите все MIDI-интерефейсы, устройства MIDI, или периферийные устройства синхронизации.

5 Включите свой компьютер.

6 Запустите Pro Tools или аудио/MIDI приложения сторонних разработчиков.

Выключайте свою систему Pro Tools в следующем порядке:

1 Выйдите из Pro Tools и любых других приложений.

Чтобы выйти из Pro Tools, выберите меню File > Exit (Windows)

или Pro Tools > Quit (Mac).
2 Уберите громкость всех выходных устройств вашей системы или отключите их.

3 Выключите компьютер.

4 Выключите все MIDI-интерефейсы, устройства MIDI, или периферийные устройства синхронизации
5 Выключите все консоли управления.

6 Выключите все внешние жесткие диски

Настройка приложения Pro Tools LE

Системные установки Pro Tools 

Pro Tools LE позволяет вам изменить через диалог Playback Engine производительность системы путем изменения системных настроек, которые влияют на ее ресурсы обработки, воспроизведения и записи. 
Mbox 2 Micro не обеспечивает внешнего входа, это исключительно выходное устройство. Соответственно, вы мне можете записывать при помощи Mbox 2 Micro внешние источники.
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В большинстве случаев настройки по умолчанию обеспечивают оптимальную производительность, но у вас может возникнуть желание их изменить для работы с большим количеством аудио материала и/или обработки.

Hardware Buffer Size
Настройка Hardware Buffer Size (H/W Buffer Size) задает размер буфера, используемого для работы с большинством процессов программной обработки, таких как плагины Real-Time AudioSuite (RTAS). Настройка H/W Buffer также может быть использована для регулировки задержки мониторинга.

· Меньшее значение Hardware Buffer Size уменьшает задержку мониторинга и полезно, когда вы осуществляете запись через аудио вход.

Хотя Mbox 2 Micro не позволяет вести запись с внешнего источника, вы можете записывать звук (например, виртуальных инструментов) через внутренние шины Pro Tools LE
· Большее значение Hardware Buffer Size обеспечивает больший ресурс обработки аудио и эффектов и полезно, когда вы осуществляете сведение и используете большое количество плагинов RTAS.

Помимо замедления отрисовки на экране и задержки мониторинга большие значения Hardware Buffer Size могут увеличивать задержку, вызываемую плагинами RTAS и повлиять на точность автоматизации плагинов, мьютов и синхронизации треков MIDI.

Чтобы изменить параметр Hardware Buffer Size:

1 Зайдите в меню Setup > Playback Engine.

2 В выпадающем меню H/W Buffer Size выберите размер аудио буфера, заданный в сэмплах.

3 Нажмите «OK».

RTAS Processors
Настройка RTAS Processors задает количество процессоров вашего компьютера, выделяемое для плагинов обработки RTAS (Real-Time Audio Suite). 

На компьютерах с более чем одним процессором эта настройка позволяет управлять поддержкой многопроцессорности для обработки RTAS. Чтобы эта настройка была доступно на многопроцессорных компьютерах с поддержкой технологии Hyper-Threading, необходимо отключить Hyper-Threading. За инструкциями о том, как войти в BIOS компьютера и отключить Hyper-Threading обращайтесь к документации на ваш компьютер.

В сочетании с настройкой CPU Usage Limit настройка RTAS Processors позволяет вам управлять тем, как плагины RTAS и другие задачи Pro Tools обрабатываются системой. Например:

· В сессиях с большим количеством плагинов RTAS вы можете выделить 2 или более процессора для обработки RTAS и задать высокое значение CPU Usage Limit.

· В сессиях с небольшим количеством плагинов RTAS вы можете выделить меньше процессоров под RTAS и установить низкое значение CPU Usage Limit, чтобы оставить больше вычислительных ресурсов для точности автоматизации, отрисовки экрана и видео
· В зависимости от важности видео и отрисовки экрана в целом, а также плотности автоматизации, пробуйте различные комбинации настроек RTAS Processing и CPU Usage Limit, чтобы получить оптимальный результат. Например, чтобы улучшить отрисовку экрана в сессии среднего размера с умеренным количеством плагинов RTAS на однопроцессорной системе, попытайтесь уменьшить количество плагинов RTAS, но держите CPU Usage Limit на максимуме.
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Чтобы задать параметр RTAS Processors:

1 Зайдите в меню Setup > Playback Engine.

2 В выпадающем меню RTAS Processors выберите доступное количество процессоров, которое вы хотите отвести под обработку плагинами RTAS. Количество доступных процессоров зависит от того, сколько процессоров установлено на вашем компьютере:

· Выбирайте 1 процессор, чтобы ограничить ресурс обработки RTAS только одним процессором в системе.

· Выбирайте 2 процессора, чтобы равномерно распределять нагрузку между двумя доступными процессорами.

· На системах с 4 или более процессорами выбирайте то количество процессоров для RTAS сколько нужно

3 Нажмите «OK».
CPU Usage Limit
Параметр CPU Usage Limit задает процент вычислительных ресурсов, отводимых на программную обработку в Pro Tools. В сочетании с параметром RTAS Processors, настройка CPU Usage Limit позволяет вам управлять тем, как задачи Pro Tools обрабатываются системой.

· Низкое значение CPU Usage Limit ограничивает эффект, который обработка в Pro Tools оказывает на другие ресурсоемкие задачи, такие как отрисовка экрана, и полезно, когда вы ощущаете медленный отклик системы, или запускаете параллельно с Pro Tools другие приложения.

· Высокие значения CPU Usage Limit выделяют больше вычислительных ресурсов Tools и полезны при воспроизведение объемных сессий или использования большого количество плагинов в реальном времени

.

Максимально доступное значение CPU Usage Limit зависит от количества процессоров в вашем компьютере и количества процессоров, которое вы отвели под обработку RTAS. Этот предел может варьироваться от 85% у однопроцессорных компьютеров до 99% у многопроцессорных компьютеров.
Увеличение параметра CPU Usage Limit может замедлить отрисовку экрана на менее производительных компьютерах.
Чтобы изменить параметр CPU Usage Limit:

1 Зайдите в меню Setup > Playback Engine.

2 В выпадающем меню CPU Usage Limit выберите процент вычислительных ресурсов, который вы хотите выделить под Pro Tools.

3 Нажмите «OK».
RTAS Engine (RTAS Error Suppression)

Опция RTAS Engine включает сообщения об ошибках RTAS во время воспроизведения и записи. Это особенно полезно, когда идет работа с инструментальными плагинами

Вы должны отключать сообщения об ошибках только в том случае, если частые ошибки RTAS прерывают ваш творческий рабочий процесс. Когда сообщения об ошибках отключены, вы можете ощутить снижения качества аудио. Однако, это может быть приемлемым, чтобы избежать остановок воспроизведения и записи при работе с инструментальными плагинами. Убедитесь, что сообщения об ошибках включены, когда вам необходимо обеспечить максимально возможное качество аудио, например при финальном миксе.

[Стр. 24]
Есть одна опция RTAS Engine:

Ignore Errors During Playback/Record. Когда она активирована, Pro Tools продолжает воспроизведение и запись, даже если потребности обработки RTAS в ресурсах превосходят значение параметра CPU Usage Limit. Это может вызвать щелчки и потрескивание в аудио, но не останавливает транспорт.

Чтобы отключить сообщения об ошибках RTAS:

1 Зайдите в меню Setup > Playback Engine.

2 Выберите «Ignore Errors During Playback/Record».

3 Нажмите «OK».
DAE Playback Buffer Size

Параметр DAE Playback Buffer Size определяет количество памяти, выделяемое под буферы дисков.  Размер буфера отображается в миллисекундах, что означает количество аудио, помещаемое в буфер, когда система читает с диска

Оптимальное значение DAE Playback Buffer Size для большинства дисковых операций – 1500 мс (Level 2).

· Значения DAE Playback Buffer Size, меньшие, чем 1500 мс (Level 2), могут уменьшить время инициализации воспроизведения или записи, но могут сказаться на устойчивости воспроизведения или записи треков при большом количестве дорожек или большой плотности редактирования, или в случае систем с медленными или сильно фрагментированными дисками.

· Значения DAE Playback Buffer Size, большие, чем 1500мс (Level 2) позволяют увеличить плотность редактирования в сессии или количество треков при медленных жестких дисках. Однако, более высокие значения могут вызвать задержку начала воспроизведения и записи или увеличение слышимой задержки воспроизведения при редактирование.
Использование больших значений DAE Playback Buffer Size оставляет меньше системной памяти для других задач. Рекомендуется использовать значение по умолчанию Level 2, если только вы не сталкиваетесь с ошибкой 9073 (“Disk too slow or fragmented”).
Чтобы изменить значение DAE Playback Buffer Size:

1 Зайдите в меню Setup > Playback Engine.

2 В выпадающем меню Playback Buffer выберите размер буфера.

3 Нажмите «OK».
Если Pro Tools требуется больше системной памяти для буфера, вас попросят перезапустить компьютер.

[Стр. 25]

Cache Size

Параметр Cache Size задает количество памяти, которое DAE выделяет при предварительной буферизации аудио для воспроизведения и создания Лупов при использовании Elastic Audio.

Для большинства сессий оптимальным значением Cache Size является «Normal».

· Значение Cache Size «Micromum» уменьшает количество системной памяти, используемой для операций с диском и освобождает память для других системных задач. Однако производительность при использовании функций Elastic Audio может упасть.

· Значение Cache Size «Large» улучшает производительность при использовании Elastic Audio, но также уменьшает количество памяти, доступное для других системных задач, таких как обработка RTAS.
Использование больших значений Cache Size оставляет меньше системной памяти для других задач. Рекомендуется настройка по умолчанию «Normal», если только вы не сталкиваетесь с ошибками -9500 (“Cache too small”).

Чтобы изменить Cache Size:

1 Зайдите в меню Setup > Playback Engine.

2 В разворачивающемся меню Cache Size выберите размер дискового кэша.

3 Нажмите «OK».

Резервирование системной памяти
Когда вы запускаете компьютер, Pro Tools автоматически резервирует часть системной памяти под буфер DAE Playback Buffer. Эта зарезервированная память недоступна другим приложениям, даже если приложение Pro Tools не открыто.

Вы можете настроить Pro Tools, чтобы резервировалось только минимальное количество памяти, и больше системной памяти было доступно для других приложений.

Чтобы минимзировать резервирование системной памяти:

1 Зайдите в меню Setup > Playback Engine.

2 Выберите опцию “Micromize System Memory Allocation”.
3 Нажмите «OK».

4 Перезапустите компьютер.

Plug-in Streaming Buffer Size 

(Только для плагина Structure)

Эта настройка появляется в диалоге Playback Engine только, когда в вашей системе установлен плагин сэмплера Structure . Параметр Plug-in Streaming Buffer Size задает количество памяти, которое DAE выделяет для потокового воспроизведения с диска плагином Structure. Эта настройка влияет на воспроизведение только, если в настройках плагина Structure активировано потоковое чтение с диска (детали см. в руководстве «Structure Plug-in Guide»).
Оптимальное значение параметра Plug-in Streaming Buffer Size для большинства сессий 250мс (Level 2).

· Значения Plug-in Streaming Buffer Size меньшие, чем 250мс (Level 2) уменьшают количество системной памяти, используемой для воспроизведения сэмплов и освобождает память для других задач. Однако, качество звучания при воспроизведении сэмплов может ухудшиться.

· Значения Plug-in Streaming Buffer Size большие, чем 250мс (Level 2) улучшают качество аудио при воспроизведении сэмплов, но также уменьшают количество памяти, доступное для других системных задач, таких как обработка RTAS.

Использование больших значений Plug-in Streaming Buffer Size оставляет меньше системной памяти для других задач. Рекомендуется значение по умолчанию 250мс (Level 2), если только вы не испытываете проблем с качеством аудио при воспроизведении сэмплов.
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Чтобы изменить значение Plug-in Streaming Buffer Size:

1 Войдите в меню Setup > Playback Engine.

2 В выпадающем меню Plug-in Streaming Buffer Size выберите размер буфера.

3 Нажмите «OK».

Оптимизация Plug-in Streaming Buffer Size

(Только для плагина Structure)

Эта опция появляется в диалоге Playback Engine только, если в вашей системе установлен плагин сэмплера Structure. Эта опция полезна, когда вы воспроизводите сэмплы с того же диска, который содержит аудио текущей сессии. Когда эта опция активирована, Pro Tools автоматически оптимизирует параметр Plug-in Streaming Buffer Size, чтобы адаптировать его как под Pro Tools, так и Structure. При включенной опции выпадающее меню Plug-in Streaming Buffer
Size не доступно.

Чтобы оптимизировать в Pro Tools параметр Plug-in Streaming Buffer Size:

1 Войдите в меню Setup > Playback Engine.

2 Выберите опцию  “Optimize for Streaming Content”.

3 Нажмите «ОК».

Аппаратные настройки Pro Tools 

Pro Tools дает вам возможность задать по умолчанию частоту дискретизации и источник синхронизации для системы, а также ряд параметров, специфических для конкретной модели аудиоинтерфейса.
Default Sample Rate
Настройка Sample Rate задает частоту дискретизации аудио, по умолчанию устанавливаемую при создании новой сессии. (Эта настройку можно изменить в диалоге Hardware Setup только, когда не открыто ни одной сессии).

Изменить частоту дискретизации при создании новой сессии Pro Tools можно, выбрав другую частоту в диалоге «New Session». (см. «Pro Tools Reference Guide»)
Чтобы изменить параметр Sample Rate по умолчанию:

1 Зайдите в меню Setup > Hardware.
Диалог Hardware Setup для Mbox 2 Micro
2 В выпадающем меню Sample Rate выберите частоту дискретизации.

3 Нажмите «OK».
Clock Source
В диалоге Hardware Setup параметр устанавливается как Internal, что поддерживает запись аналоговых сигналов напрямую в Mbox 2 Micro через аналоговые входы 1-2.
Настройка ввода/вывода I/O Setup
Через диалог I/O Setup вы можете маркировать в Pro Tools LE сигнальные тракты входов, выходов, инсертов и шины. Диалог I/O Setup дает графическое отображение выходов и маршрутизации сигнала в Mbox 2 Micro.

Mbox 2 Micro не имеет внешнего входа, это исключительно  устройство вывода.

Pro Tools LE имеет установки I/O Setup по умолчанию, с которых можно начать работу. Используйте диалог I/O Setup, только если вы хотите переименовать тракты ввода/вывода по умолчанию.
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.
Чтобы переименовать тракты ввода/вывода через I/O Setup:

1 Зайдите в меню Setup > I/O.

2 Выберите закладку Input, Output, Insert или Bus, чтобы отобразились соответствующие соединения.

Поскольку Mbox 2 Micro не имеет внешних входов, в диалоге I/O Setup не будет опций Input или Insert.

3 Чтобы переименовать тракт или суб-тракт, выберите его имя двойным щелчком, наберите новое имя, и нажмите «Enter».

4 Нажмите «OK».

См. «Pro Tools Reference Guide» (или выберите меню Help > Pro Tools Reference Guide) за дополнительной информацией о переименовании трактов ввода/вывода

Настройка MIDI

Если вы планируете использовать вместе с Pro Tools LE какие-либо устройства MIDI:

В системах Windows, настройте MIDI через MIDI
· Studio Setup. См. Приложение А «Настройка MIDI Studio Setup (только для Windows)

– или -

· В системах Mac, настройте MIDI через утилиту Apple Audio MIDI Setup (AMS) utility. См. приложение В “Настройка AMS (только для Mac OS X».

Резервное копирование конфигурации системы

После настойки своей системы и Pro Tools вам следует сохранить образ своего системного диска при помощи утилиты резервного копирования, такой как Bombich Carbon Copy Cloner. Таким образом вы можете быстро восстановить конфигурацию системы и настройки в случае возникновения каких-либо проблем.

Оптимизация системы Windows для Pro Tools

(Только Windows XP)
Чтобы оптимизировать для Pro Tools систему Mac, см. «Оптимизация систем Mac для Pro Tools», стр. 30.

Перед тем, как настраивать свой компьютер, убедитесь, что учетная запись, под которой вы производите установку Pro Tools имеет права Администратора. Подробно о правах Администратора рассказывается в документации Windows.

Необходимая оптимизация

Чтобы добиться оптимальной производительности от Pro Tools LE, произведите следующие настройки перед установкой аппаратной и программной составляющих системы Pro Tools.

После изменения параметров системы Windows перезагрузите компьютер
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Активация DMA
Актививровав на своем компьютере DMA (Direct Memory
Access), вы освобождаете ресурсы процессора для выполнения задач Pro Tools.

В большинстве случаев параметры DMA уже корректно установлены, поскольку Windows XP определяет и активирует режим DMA по умолчанию

.

Чтобы активировать DMA для любого жесткого диска:

1 Выберите Пуск > Настройка > Панель управления.

2 В окне настроек двойным щелчком выберите «Система».

3 Выберите закладку «Оборудование»

4 В разделе «Диспетчер Устройств» нажмите кнопку «Диспетчер Устройств»

5 В окне «Диспетчер Устройств» выберите двойным щелчком «IDE ATA/ATAPI контроллеры», затем двойным щелчком выберитк  controllers, then double-click

the «Первичный канал IDE» своего диска

6 Выберите закладку «Дополнительные параметры».

7 Для каждого устройства установите Режим Передачи «DMA, если доступно» и нажмите кнопку «OK».

8 Повторите шаги 5–7 для всех дополнительных каналов IDE.

9 Закройте окно настройки системы.

Отключение ждущего режима и управления электропитанием

При использовании Pro Tools схема питания ждущего режима Windows должна быть установлена в режим «Включен постоянно» это помогает предотвратить остановку долговременного проигрывания или записи из-за отключений питания в системе.

Чтобы настроить электропитание Windows:

1 Выберите Пуск > Настройка > Панель управления.

2 В окне настроек двойным щелчком выберите «Электропитание».

3 Выберите закладку «Схемы управления питанием».

4 В разворачивающемся меню «Схемы управления питанием» выберите «Включен постоянно».

5 Нажмите кнопку «OK».

Это установит функции режима ожидания, спящего режима и отключения жестких дисков в состояние «Никогда».

В случае процессоров AMD обязательно убедитесь в том, что функция «Cool N’Quiet» отключена в BIOS (раздел «Cool & Quiet Configuration»).

При необходимости подробных инструкций по отключению этой опции энергопитания обратитесь к документации производителя.

Отключение функции сглаживания экранных шрифтов

При работе с Pro Tools эффект сглаживания экранных шрифтов должен быть отключен.

Чтобы отключить эффект сглаживания экранных шрифтов:

1 Выберите Пуск > Настройка > Панель управления.

2 В окне настроек двойным щелчком выберите «Экран»

3 Выберите закладку «Оформление».

4 Нажмите кнопку «Эффекты».

5 Снимите галочку «Применять следующий метод сглаживания экранных шрифтов»

6 Нажмите кнопку «OK», чтобы сохранить настройки, и закройте диалог «Эффекты».

7 Нажмите «OK».

8 Перезагрузите компьютер.
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Рекомендумая оптимизация

На работу Pro Tools может влиять другое ПО и драйверы оборудования, установленные на вашем компьютере.

Рекомендуется (но не требуется) поступать следующим образом:

• Избегать работы программ, не являющихся необходимыми, одновременно с Pro Tools.

• Отключать любые, работающие в фоновом режиме программные утилиты, такие как Windows Messenger, программы календарных оповещений и обслуживания дисков.

• Отключать любые не нужные принципиально устройства USB на время работы с Pro Tools.

• Если ваша видео карта поддерживает режим Bus Mastering, установите его в панели управления устройства. Подробности содержатся в документации производителя.

Дополнительная оптимизация

Следующие варианты оптимизации системы могут помочь повысить эффективность работы Pro Tools на некоторых компьютерах. Рекомендуется пробовать такие способы оптимизации только в случае необходимости, поскольку они могут прервать или ухудшить работу других программ в вашей системе.

Отключение сетевых плат

Если возможно, отключите все сетевые платы (кроме карт FireWire, которые используются для подключения к системе внешних дисков).

Чтобы отключить сетевую плату:

1 Правым щелчком по иконке Мой Компьютер откройте меню и выберите пункт «Управление».

2 В разделе «Служебные программы» выберите «Диспетчер Устройств».

3 В окне «Диспетчер Устройств» двойным щелчком выберите раздел «Сетевые платы», затем двойным щелчком выберите сетевой адаптер, который хотите отключить.

4 В закладке «Общие» выберите в разворачивающемся меню «Применение устройства» вариант «Это устройство не используется (отключено) и нажмите кнопку «OK».

5 Закройте окно «Управление компьютером»

.

Распределение ресурсов процессора

Чтобы настроить распределение ресурсов процессора:

1 Выберите Пуск > Настройка > Панель управления.

2 В окне настроек двойным щелчком выберите «Система».

3 Выберите закладку «Дополнительно».

4 В разделе «Производительность» нажмите кнопку «Параметры».

5 В окне «Параметры быстродействия» выберите закладку «Дополнительно».

6 В разделе Распределение времени процессора выберите опцию «служб, работающих в фоновом режиме».

7 В разделе «Использование памяти» выберите опцию «системного кэша».

8 Нажмите кнопку « OK», чтобы закрыть окно «Параметры быстродействия» 

9 Нажмите кнопку « OK», чтобы закрыть окно «Свойства системы».

10 Перезагрузите компьютер, чтобы изменения вступили в силу
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Отключение автоматически запускаемых программных модулей

Чем меньше программ работает на вашем компьютере, тем больше ресурсов доступно Pro Tools. Некоторые из автоматически запускаемых приложений могут бесполезно потреблять ресурсы процессора, и должны быть отключены.

Если вы решите отключить какой-либо из пунктов автозагрузки, делайте это обдуманно:

• Определение серийных номеров съемных носителей (требуется для приложений с ключом защиты от копирования)

• Plug-n-play
• Журнал событий

• Криптографические сервисы

• Клиент DHCP, TCP/IP Net BIOS, и другие сетевые сервисы (в случае, если компьютер не имеет сетевых подключений все эти сервисы могут быть без проблем отключены)

Чтобы отключить автоматическую загрузку программ:

1 В меню «Пуск» выберите пункт «Выполнить…»

2 Наберите в строке ввода “msconfig” и нажмите кнопку «OK». Откроется утилита «Настройка системы».

3 В закладке «Общие» выберите «Выборочный запуск».

4 В закладке отключите опцию «Запуск объектов автозагрузки» и нажмите кнопку «OK».

5 Перезагрузите компьютер.

6 После перезапуска компьютер отобразит сообщение об изменении конфигурации системы. Перед тем, как выбрать вариант «Не показывать это сообщение снова», проверьте, увеличилась ли производительность Pro Tools. Если производительность не изменилась, запустите “msconfig” и верните режим автозапуска в «Обычный». Как вариант, попробуйте отключать запуск приложений автозагрузки и ненужных процессов выборочно

Оптимизация системы Mac для Pro Tools 

(Только Mac OS X)

Чтобы оптимизировать для Pro Tools систему Windows XP, см. «Оптимизация систем Windows для Pro Tools», стр. 27.

Чтобы добиться оптимальной производительности от Pro Tools LE, произведите следующие настройки перед установкой аппаратной и программной составляющих системы Pro Tools.

Перед тем, как настраивать свой компьютер, убедитесь, что учетная запись, под которой вы производите установку Pro Tools имеет права Администратора. Подробно о правах Администратора Mac OS X рассказывается в документации Apple OS X 

Не используйте в Mac OS X функцию Automatic Software Update, поскольку она может обновить вашу систему до версии Mac OS, не сертифицированной на совместимость с Pro Tools. Подробности о сертификации версии Mac OS можно узнать в свежей информации о совместимости на сайте Digidesign (www.digidesign.com).

Отключение Software Update
Чтобы отключить функцию Software Update:

1 Выберите System Preferences в меню Apple, затем выберите Software Update.

2 Выберите Update Software и снимите отметку с Check for Updates

[Стр. 31]
Выключение функции Energy Saver

Чтобы выключить функцию Energy Saver:

1 Выберите System Preferences в меню Apple, затем выберите Energy Saver.

2 Выберите Sleep, после чего:

• Установите настройку «computer sleep» Never.

• Установите настройку «setting to» Never.

• Снимите отметку с опции “Put the hard disk(s) to sleep when

possible”.

Настройка производительности процессора 

(Только для компьютеров Mac G5)

Чтобы установить параметр Processor Performance:

1 Выберите System Preferences в меню Apple, затем выберите Energy Saver.

2 Выберите Options и установите значение «Processor Performance» Highest.

Отключение функции Spotlight Indexing
В Mac OS X функция Spotlight в фоновом режиме индексирует файлы и папки, влияя на производительность системы.

Рекомендуется перед работой с Pro Tools отключать индексирование Spotlight.

Отключение индексирования Spotlight приведет к тому, что функция Find в Mac OS X больше не будет работать. Не сможете вести поиск файлов на дисков, установленных в режим Privacy.

Чтобы отключить индексирование Spotlight:

1 Выберите System Preferences в меню Apple, затем выберите Spotlight.

2 В окне Spotlight выберите Privacy.

3 Чтобы диск не индексировался, перетащите его иконку с рабочего стола в список.

Отключение горячих клавиш Spotlight

Функция Mac OS X Spotlight использует те же самые горячие клавиши, что используются в Pro для запуска записи (Command+Пробел) и записи-врезки (Command+Option+Пробел). Если вы хотите сохранить использование этих комбинаций в Pro Tools, вы должны отключить их в Spotlight.

Чтобы отключить горячие клавиши Spotlight:

1 Выберите System Preferences в меню Apple, затем выберите Spotlight.

2 Снимите отметку с “Spotlight menu keyboard shortcut” и “Spotlight window keyboard shortcut.”

Отключение горячей клавиши панели Dashboard

Панель быстрого доступа Mac OS X Dashboard использует ту же клавишу, что используется в Pro Tools для начала записи (F12). Если вы хотите сохранить ее использование в Pro Tools, вы должны отключить ее в Dashboard.

Чтoбы отключить горячую клавишу панели Dashboard:

1 Выберите System Preferences в меню Apple, затем выберите Dashboard, затем Exposé.

2 Установите горячую клавишу Dashboard в “–”, чтобы отключить ее.

[Стр. 32]
Включение функции Journaling для дисков с аудио
Если вы планируете использовать аудио диск, который использовали с предыдущей версией Pro Tools на Mac, включите функцию Journaling.

Чтобы включить функцию Journaling:

1 Запустите приложение Disk Utility, находящееся в Applications/Utilities.

2 Выберите том в левой колонке окна Disk Utility.

3 На панели инструментов нажмите Enable Journaling
[Стр. 33]

Раздел 6. Обзор аудиоинтерфейса Mbox 2 Micro

Аппаратные характеристики Mbox 2 Micro

Mbox 2 Micro имеет следующие аппаратные характеристики:

1/8” (3.5мм) стерео выход

Используйте 1/8” (3.5мм) стерео для подключения стерео наушников с 1/8” (3.5мм) стерео Джеком. При помощи соответствующих кабелей и адаптеров вы также можете подключаться к микшеру или звуковой стерео системе.

Регулировка громкости

Регулировка громкости задает выходной уровень на 1/8” (3.5мм) стерео выходе. В Pro Tools это сигнал, маршрутизируемый на выходы Output 1 и 2.

Индикатор USB

Индикатор USB показывает, что Mbox 2 Micro получает питание по подключению USB. Если он светится, вы можете проигрывать аудио через 1/8” (3.5мм) стерео выход Mbox 2 Micro. 

Ушко под шнурок

Используйте это ушко, чтобы прикрепить свой Mbox 2 Micro к шейному шнурку или брелку.

Подключение к оборудованию

Чтобы слышать звук, воспроизводимый в сессии Pro Tools, вам нужно подключить наушники или внешнюю звуковую систему (например, активные мониторы или домашнюю стереосистему) к Mbox 2 Micro. Звуки из Mbox 2 Micro не может воспроизводиться через встроенные динамики или звуковую карту вашего компьютера.

Подключение наушников
На панели Mbox 2 Micro находится 1/8” (3.5мм) джек для подключения наушников. 

Используйте регулировку громкости, чтобы задать выходной уровень.

Чтобы подключить наушники:

Подключите наушники с 1/8” (3.5мм) стерео джеком (или адаптером) к выходу на наушники.
[Стр. 34]
Подключение к звуковой системе
Вы также можете подключить 1/8” (3.5мм) стерео выход к стерео звуковой системе (профессиональной системе звукоусиления или своей домашней стерео системе). Однако вам моджет понадобиться Y-образный кабель с одним 1/8” (3.5мм) стерео Джеком и двумя RCA разъемами или адаптер на 1/4” (6.35мм) джек, в зависимости от вашей звуковой системы.

В домашних стерео системах часто используются разъемы RCA. Вы можете использовать адаптеры или специальные кабели, чтобы подключать  1/8” (3.5мм) TRS (Tip-Ring-Sleeve) выход Mbox 2 Micro к разъемам RCA на вашей домашней стерео системе.

 [Стр. 35]
Раздел 7. Основные задачи в Pro Tools LE
Этот раздел призван дать новым пользователям представление о конкретных методах работы при выполнении основных задач в системе Pro Tools.

Самая подробная информация по работе с Pro Tools содержится в «Pro Tools Reference Guide».

Вы можете просмотреть электронную версию документа в формате PDF через меню Help в Pro Tools menu.

Создание сессии Pro Tools
Вы можете использовать Mbox 2 Micro, чтобы создать новую сессию Pro Tools или открыть и воспроизвести существующую сессию Pro Tools. Работая с Mbox 2 Micro вы также можете импортировать аудио и MIDI для воспроизведения, а также пользоваться виртуальными инструментами (такими, как инструментальный плагин Digiesingn Xpand!).

Чтобы создать сессию Pro Tools:

1 Проверьте подключение Mbox 2 Micro (см. «Подключение к оборудованию», стр. 33)
2 Запустите Pro Tools.

3 Зайдите в меню File > New Session.

4 В диалоге New Session при необходимости задайте параметры сессии или оставьте их по умолчанию. (Подробно о настройках New Session см «Pro Tools Reference Guide».)
Диалог New Session

5 Выберите место сохранения своей сессии.

6 Задайте имя своей сессии.

7 Нажмите «Save».

[Стр. 36]
Открытие и воспроизведение сессии Pro Tools
Чтобы открыть существующую сессию:

8 Войдите в меню File > Open Session.

9 Выберите сессию, которую хотите открыть, и нажмите «Open».

.

Если вы только знакомитесь с Pro Tools, попробуйте открыть и воспроизвести демо-сессию Pro Tools. Для систем Windows см «Демонстрационная сессия Pro Tools», стр. 12», Для систем Mac см «Демонстрационная сессия Pro Tools», стр. 18».

Вы также можете открыть сессию двойным щелчком через браузер DigiBase. Детали о браузерах DigiBase см. в «Pro Tools Reference Guide»

Чтобы воспроизвести сессию Pro Tools:

1 Уберите выходную громкость на Mbox 2 Micro.

2 В окне Transport, нажмите «Return to Zero», если хотите начать воспроизведение с начала сессии.

3 Чтобы начать воспроизведение нажмите кнопку «Play» в окне Transport, или нажмите клавишу пробела.

4 Установите выходную громкость Mbox 2 Micro на приемлемом уровне.

5 Чтобы остановить воспроизведение нажмите кнопку «Stop» в окне Transport, или нажмите клавишу пробела.

Импортирование аудио с CD
Чтобы импортировать аудио с компакт-диска:

1 Вставьте CD с аудио материалом в привод CD/DVD.

2 Откройте в Pro Tools браузер Workspace через меню Window > Workspace. Браузер Workspace – это окно через которое вы можете осуществлять поиск, предварительное прослушивание и организацию своих аудио файлов.

Браузер Workspace – это окно, в котором вы можете осуществлять поиск, прослушивание и управление своими аудио файлами. Дополнительную информацию о бразуерах DigiBase и Workspace см в «Pro Tools Reference Guide».

3 В браузере Workspace щелкните на иконке «Audio CD», чтобы увидеть файлы на CD.
4 Для предварительного прослушивания аудио файла, щелкните на иконке динамика в колонке Waveform. Чтобы остановить воспроизведение, нажмите клавишу пробела.

Предварительное прослушивание аудиофайла в браузере Workspace
[Стр. 37]

5 Чтобы импортировать файл в новый трек, перетащите его из браузера Workspace в список Track List окна редактирования Edit.

Перенос аудио файла из браузера Workspace в список Track List окна Edit.
Вы можете перетащить любой аудиофайл из любого браузера DigiBase или с рабочего стола прямо в сессию Pro Tools. Однако, помните, что Pro Tools может импортировать только поддерживаемые форматы аудио файлы. Дополнительную информацию см. в «Pro Tools Reference

Guide».

Чтобы воспроизвести новый трек: 

1 В окне Transport нажмите кнопку сброса в ноль, чтобы перейти в начало трека

2 На передней панели Mbox 2 Micro поверните ручку «Mix» до упора вправо (положение «Playback»).

3 Чтобы начать воспроизведение, нажмите кнопку «Воспроизведение» в окне транспорта или клавишу пробела.

4 Чтобы остановить воспроизведение, нажмите кнопку «Стоп» в окне транспорта или клавишу пробела.

Создание аудио CD из сессии Pro Tools
Pro Tools не создает аудио CD непосредственно, но вы можете создавать из своих сессий Pro Tools стерео аудио файлы, которые могут быть использованы большинством программ записи CD
Сброс аудио на диск

Используйте функцию Pro Tools «Bounce to Disk», чтобы собрать все слышимые треки в один «мастер» аудио файл. После того, как новый аудио файл сброшен на диск, вы можете нарезать его на CD.

Если вы сбрасываете аудио с 24-битным разрешением в 16-битный формат (разрешение CD), вам следует использовать на главном выходе плагин дитеринга. (Подробности см. в «Pro Tools Reference Guide».)

[Стр. 38]

Рис.1. Аудио материал сессии выбран и готов к сбросу 

[Стр. 39]

Чтобы сбросить аудио на диск:

1 После того, как вы закончили запись и сведение сессии в Pro Tools задайте на линейке отсчета времени (или на треке) продолжительность сессии, добавив также некоторое количество времени, чтобы избежать обрывания хвостов реверберации, которые могут продолжать звучать после последнего региона.

2 Выберите меню File > Bounce to > Disk.

Выбор Bounce to Disk в меню File

3 В диалоге Bounce Options выберите Outputs 1–2 в качестве значения параметра Bounce Source.

4 Выберите BWF (.WAV) в качестве значения File Type.

5 Выберите Stereo Interleaved в качестве значения Format.

6 Выберите 16 в Resolution и 44100 в Sample Rate.

7 Если вы меняете частоту дискретизации в файле сброса, задайте параметр Conversion Quality.

(Подробности см. в «Pro Tools Reference Guide».)

 Выберите “Convert after Bounce” и нажмите «Bounce». 

Опции Bounce для создания треков пригодных к нарезке на CD
[Стр. 40]

9 В диалоге Bounce задайте имена сбрасываемым трекам и выберите место, в котором они должны быть сохранены.
Ввод имени сбрасываемого файла
10 Нажмите «Save».

Pro Tools начинает сброс на диск. Сброс в Pro Tools осуществляется в реальном времени, поэтому вы можете слышать воспроизведение своего микса в процессе сброса (но не можете что-то изменить)
Диалог Bouncing to Disk

Запись CD

После того, как сброс завершен, у вас будет аудио файл, готовый к нарезке на CD. Выйдите из Quit Pro Tools и запустите любое из распространенных приложений для прожига CD, чтобы нарезать на CD сброс своего микса.

Убедитесь, что ваше приложение записи CD настроено так, чтобы создать аудио CD, а не CD с данными.

[Стр. 41]
Запись MIDI в сессии Pro Tools
Что такое MIDI?

Информация MIDI (Musical Instrument Digital Interface) – это не аудио и не содержит собственно звуков. MIDI – это коммуникационный протокол для музыкальных устройств. MIDI – это данные, которые могут управлять устройством, поддерживающим MIDI (например, клавишным инструментом или программным синтезатором).

Чтобы создать или воспроизвести запись MIDI вам требуется MIDI-контроллер или звуковой модуль (аппаратный или виртуальный), подключенные к компьютеру через порты MIDI или MIDI-интерфейс. 

Поскольку Mbox 2 Micro не имеет портов MIDI, вам потребуется отдельный MIDI-интерфейс, чтобы использовать с Pro Tools внешние устройства MIDI.

Через Mbox 2 Micro возможен мониторинг аудио только виртуальных MIDI-инструментов. Чтобы осуществлять мониторинг внешних MIDI-инструментов, используйте внешний микшер.

[Стр. 41]

Запись MIDI в формате Instrument Track
В Pro Tools треки типа Instrument Track обеспечивают как MIDI так и аудио функциональность, поэтому вы можете записывать MIDI, и осуществлять аудио мониториг через программные или аппаратные инструменты.

Вы также можете вручную вводить ноты и управляющую информацию MIDI в Pro Tools при помощи средства  Pencil Tool. Дополнительную информацию см. в «Pro Tools Reference

Guide».

Чтобы создать дорожку Instrument Track и настроить ее на запись:

1 Войдите в меню Setup > MIDI > Input Devices, убедитесь, что ваше входное устройство выбрано в окне MIDI Input Enable и нажмите «OK».

2 Войдите в меню Track > New, задайте тип «1 Mono Instrument Track», затем нажмите «Create».

3 Выберите пункт меню View > Mix Window > Instruments, чтобы отобразились параметры MIDI для дорожки типа Instrument
4 В окне Mix сверху дорожки типа Instrument откройте селектор входа MIDI и назначьте на запись устройство и канал или поставьте «All».

Селектор входа MIDI 

Селектор входа MIDI у трека типа Instrument
[Стр. 42]
5 В зависимости от типа инструмента, который вы используете сделайте одно из следующего:

• Если вы используете плагин виртуального инструмента, откройте селектор Insert и назначьте плагин на трек типа Instrument. MIDI выход трека автоматически будет назначен на инструментальный плагин.

Назначение инструментального плагина в треке типа Instrument
• Если вы используете внешнее устройство MIDI, откройте селектор MIDI Output трека (сверху трека типа Instrument) и назначьте устройство и канал, которые должны получать выход MIDI (выбор зависит от устройства). Работая с Mbox 2 Micro, вы должны использовать для мониторинга аудио от внешних устройств MIDI их собственные выходы на наушники либо внешний микшер или усилитель.

Если подключенное MIDI- устройство не видно, проверьте конфигурацию компьютера и его настройки MIDI.

6 В окне Mix нажмите кнопку назначения трека на запись, что бы подготовить ваш трек типа Instrument к записи MIDI..

Track Record Enable button

Назначение трека типа Instrument для записи MIDI 

7 Убедитесь, что выбрана опция Options > MIDI Thru.

8Сыграйте несколько нот на своем MIDI -контроллере и посмотрите на реакцию индикатора MIDI Velocity трека. Помните, MIDI – не аудио, и индикатор MIDI Velocity фиксирует не громкость аудио, а активность MIDI.

Индикатор MIDI Velocity

Индикатор MIDI трека типа Instrument показывает активность MIDI. 
[Стр. 43]
9 Отрегулируйте громкость аудио выхода трека типа Instrument его фейдером громкости.

Фейдер громкости
Регулировка фейдера громкости трека типа Instrument
Чтобы записать MIDI в треке типа Instrument:

1 Убедитесь, что трек типа Instrument, который вы хотите записать, назначен на запись и принимает MIDI.

2 В окне Transport нажмите кнопку сброса в ноль, чтобы перейти в начало трека.

Вы также можете записывать в выбранный участок трека или с точки установленного в окне Edit курсора.

3 Нажмите кнопку «Запись» в окне транспорта.

4 Чтобы начать запись нажмите кнопку воспроизведения в окне транспорта или нажмите клавишу пробела.

5 Играйте на MIDI контроллере или на другогом входном устройстве.

6 По окончании записи нажмите кнопку «Стоп» в окне транспорта или клавишу пробела.

Только что записанная информация MIDI появится как регион MIDI на треке в окне Edit, а также в списке регионов.

Данные MIDI в треке типа Instrument

Чтобы воспроизвести записанные данные MIDI:

1 Нажмите кнопку назначения трека на запись, чтобы вывести его из режима записи.

2 В окне Transport нажмите кнопку сброса в ноль, чтобы перейти в начало трека.

3 Чтобы начать воспроизведение, нажмите кнопку «Воспроизведение» в окне транспорта. Записанные данные MIDI будут воспроизводиться через назначенный на трек инструмент и канал.

С Mbox 2 Micro, вы можете записывать аудио выход инструментальных плагинов по внутренней шине в аудио треки. Это может быть полезным для освобождения ресурсов процессора при дальнейшей обработке и микшировании. Дополнительную информацию см. в «Pro Tools Reference Guide».
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Приложение A: Настройка MIDI Studio Setup (только для Windows)
Настройка MIDI Studio Setup
Настройка MIDI Studio Setup (MSS) позволяет вам настроить MIDI - контроллеры и звуковые модули, которые подключены к вашей системе, и управлять маршрутизацией данных MIDI между вашим оборудованием MIDI и Pro Tools.

MSS автоматически находит интерфейсы MIDI и дает возможность задать оригинальное имя каждому из портов MIDI в документе MIDI Studio Setup.

MSS также поддерживает файлы имен патчей на основе XML для хранения и импортирования имен патчей ваших внешних устройств MIDI.

Конфигурации MIDI Studio Setup, созданные в MSS могут быть целиком импортированы и экспортированы.

Окно MIDI Studio Setup

Окно MIDI Studio Setup разделено на три секции. Настройки интерфейса находятся сверху окна. Все заданные на данный момент инструменты отображены в спискe Name в левой части окна. Детальное отображение параметров MIDI находится в секции Properties справа.

Окно MIDI Studio Setup

Настройки интерфейса

Create Эта кнопка добавляет новый инструмент в список Name.

Delete Эта кнопка удаляет выбранный инструмент или инструменты из списка Name.

Import Эта кнопка позволяет вам импортировать готовый файл MIDI Studio Setup
Export Эта кнопка позволяет вам экспортировать текущий файл MIDI Studio Setup.
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Show Duplicate Emulated Ports Когда выбрана эта опция, и вы используете MIDI-интерфейс , который поддерживает time stamp (например, MIDI I/O), окно MIDI Studio отображает как выходные порты с time-stamp DirectMusic, так и эмулируемые дубликаты без time-stamp.

Некоторые интерфейсы MIDI не могут корректно загрузить или выгрузить свои драйверы, если вы не закроете и не перезапустите Pro Tools. Подробную информацию ищите в документации своего интерфейса MIDI. 
Список инструментов 

Список инструмента содержит все заданные на текущий момент инструменты. Выбрав инструмент в списке, вы увидите его параметры в секции Properties.

Секция Properties

Секция Properties позволяет вам редактировать информацию о новых инструментах, или инструментах выбранных в списке инструментов. Когда вы выбираете очередной инструмент в списке, секция Properties изменяется в соответствии с его параметрами.

Секция Properties окна MIDI Studio Setup 

Чтобы задать инструмент через MIDI Studio Setup:

1 Выберите меню Setup > MIDI > MIDI Studio.

2 Нажмите «Create».

3 В поле Instrument Name введите имя своего инструмента и нажмите «Ввод».

Если вы не ввели имя инструмента, поле Instrument Name будет автоматически заполнено информацией из полей Manufacturer и Model.

4 Задайте производителя и модель нового устройства в соответствующих выпадающих меню. Если меню Manufacturer и Model не предлагают выбор, соответствующий конкретно вашему устройству, выбирайте «None».

5 В выпадающем меню Input выберите входной порт на вашем интерфейсе MIDI, который подключен к выходу MIDI Out вашего инструмента.

6 В выпадающем меню Output выберите выходной порт на вашем интерфейсе MIDI, который подключен к входу MIDI In вашего инструмента.

7 Активируйте соответствующие каналы MIDI (1–16) в опциях Send Channels и Receive Channels (Это определяет какие каналы работают на передачу и прием MIDI.)
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Instrument Name

Поле Instrument Name отображает задаваемое пользователем имя для выбранного инструмента.

Manufacturer

Выпадающее меню Manufacturer предлагает список производителей оборудования MIDI . Список загружается из XML файлов устройств MIDI.

Подробнее см “Поддержка имен патчей MIDI”, стр. 53.

Model

Выпадающее меню Model предлагает список устройств MIDI, отобранных по имени производителя. Этот список загружается из XML файлов устройств MIDI, предоставляемых при установке Pro Tools.

Подробнее см “Поддержка имен патчей MIDI”, стр. 53.

Input Port

Выпадающее меню Input Port отображает список доступных входных портов интерфейса MIDI. Входы будут включать в себя все интерфейсы MIDI, активные в вашей системе. Установленный и отображаемый порт интерфейса MIDI – это тот порт, через который данные посылаются от внешнего устройства MIDI, заданного в поле Name, на ваш MIDI-интерфейс.

Если входной порт задан как «None», данный инструмент не появится как вариант в селекторе входов MIDI.

Output Port
Выпадающее меню Output Port отображает список доступных выходных портов интерфейса MIDI. Установленный и отображаемый порт интерфейса MIDI – это тот порт, через который данные посылаются на внешнее устройство MIDI, заданное в поле Name, от вашего интерфейса MIDI.

Если выходной порт задан как «None», данный инструмент не появится как вариант в селекторе выходов MIDI.

Send Channels

Сетка Send Channels задает каналы передачи для устройства MIDI, заданного в поле Name.

Receive Channels

Сетка Receive Channels задает каналы приема для устройства MIDI, заданного в поле Name.

Поддержка имен патчей MIDI

Pro Tools поддерживает формат XML (Extensible Markup Language) для хранения и импортирования имен патчей ваших внешних устройств MIDI. Pro Tools устанавливает файлы имен патчей MIDI (.midnam) для фабричных патчей по умолчанию у большинства распространенных устройств MIDI. Эти файлы хранятся в каталогах, отсортированных по имени производителя в папке Program Files\Common Files\Digidesign\MIDI Patch Names\Digidesign.

Чтобы импортировать имена патчей MIDI в Pro Tools:

1 Проверьте имя устройства MIDI в окне MIDI Studio Setup (см. “Настройка MIDI Studio Setup”, стр. 47).

2 Убедитесь, что выход трека MIDI корректно назначен на устройство MIDI.

[Стр. 48]
3 Нажмите кнопку выбора патча у трека MIDI.

Кнопка выбора патча
Кнопка выбора патча, окно Edit
Кнопка выбора патча
Кнопка выбора патча, окно Mix
4 В диалоге выбора патча нажмите кнопку «Change»

Кнопка «Change»

Диалог выбора патча

5 В диалоге Open откройте папку Program Files\Common Files\Digidesign\MIDI Patch Names\Digidesign\<имя производителя> и выберите файл с именами патчей MIDI (.midnam) для устройства MIDI.
Диалог выбора патча с именами патча

6 Нажмите «Open».

Диалог выбора патча будет наполнен именами патчей, и выпадающее меню Patch Name Bank появится в левом верхнем углу окна.

После того, как имена патчей импортированы в Pro Tools, они становятся доступными для данного MIDI - устройства во всех сессиях. 

Чтобы очистить список имен:

В диалоге выбора патча нажмите кнопку «Clear», после чего нажмите Done.

Файлы с именами патчей MIDI (.midnam) могут быть отредактированы в любом текстовом редакторе, также можно использовать сторонние разработки для редактирования и упорядоченного хранения имен патчей, чтобы создавать собственные имена патчей.
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Приложение B. Настройка AMS (Только Mac OS X)

Audio MIDI Setup

Pro Tools опознает порты на вашем MIDI - интерфейсе как стандартные (generic) порты. В Mac OS X используется утилита Apple Audio MIDI Setup (AMS) для идентификации внешних устройств MIDI, подключенных к вашему MIDI- интерфейсу, и настройки вашей MIDI студии для работы с Pro Tools.

Чтобы настроить свою MIDI студию через AMS:

1 Сделайте следующее:

• Запустите Audio MIDI Setup (находится в Applications/Utilities).

– или –

• В Pro Tools, выберите меню Setup > MIDI > MIDI

Studio.

2 Выберите «MIDI Devices». AMS просканирует вашу систему на подключенные интерфейсы MIDI. Если ваш MIDI-интерфейс правильно подключен, он появится в окне со всеми пронумерованными портами.

3 Для каждого MIDI - устройства, подключенного к MIDI-интерфейсу выберите «Add Device». Появится иконка нового внешнего устройства с изображением по умолчанию в виде MIDI клавиатуры.

4 Перетащите иконку нового устройства в удобное место внутри окна.

5 Соедините MIDI - устройство с MIDI-интерфейсом щелкните на стрелке соответствующего выходного порта устройства и протянув связь или «кабель» к входной стрелке соответствующего входного порта MIDI-интерфейса.

Организация входных и выходных соединений MIDI (на примере Digidesign Command|8)

6 Щелкните на стрелке соответствующего входного порта устройства и протяните связь или «кабель» к выходной стрелке соответствующего выходного порта MIDI-интерфейса.

Чтобы удалить соединение, выберите «кабель» и нажмите «Delete». Чтобы удалить все соединения, нажмите «Clear Cables».

7 Повторите шаги 3–6 для каждого MIDI устройства в вашей конфигурации MIDI.
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Чтобы задать конфигурацию внешнего устройства миди:

1 Выберите иконку внешнего устройства, после чего выберите команду Show Info (или сделайте двойной щелчок на иконке нового устройства).

Иконка внешнего устройства

2 В соответствующих выпадающих меню выберите производителя и модель нового устройства.

(Если меню Manufacturer и Model не предлагают выбор, соответствующий конкретно вашему устройству вы можете набрать имя вручную).

Именование нового устройства MIDI

За названиями производителя и модели  AMS обращается к одному или более файлу с расширением “.middev” в каталоге Root/Library/Audio/MIDI Devices. Pro Tools устанавливает файл, содержащий информацию о многих доступных в продаже устройствах MIDI, под названием “Digidesign Device List.middev”. Если имена производителя или модели для какого-либо из ваших внешних MIDI устройств не содержатся в выпадающих меню AMS Manufacturer и Model, вы можете добавить их, отредактировав файл.middev в любом текстовом редакторе (например, TextEdit).

3 Выберите стрелку More Properties, чтобы расширить диалог, после чего  активируйте соответствующие каналы MIDI (1–16) в опциях Transmits и Receives Channels (Это определяет какие каналы будет использовать устройство для передачи и приема MIDI.)

Активация каналов MIDI 
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4 Щелкните на изображении устройства. Откроется окно, отображающее изображения для различных устройств MIDI (таких как клавишные, модули, интерфейсы и микшеры). Выберите иконку для своего устройства.
Выбор иконки устройства

Чтобы использовать свои собственные иконки, вы можете разместить графические файлы TIFF в папке /Library/Audio/MIDI Devices/Generic/Images,и они появятся как варианты в окне устройств AMS

5 Нажмите «OK».

Имена устройств, которые вы вводите, появляются в Pro Tools в качества вариантов входа и выхода MIDI.

Поддержка имен патчей MIDI
Pro Tools поддерживает формат XML (Extensible Markup Language) для хранения и импортирования имен патчей ваших внешних устройств MIDI. Pro Tools устанавливает файлы имен патчей MIDI (.midnam) для фабричных патчей по умолчанию у большинства распространенных устройств MIDI. Эти файлы хранятся в каталогах, отсортированных по имени производителя в папке /Library/Audio/MIDI Patch Names/Digidesign.

Чтобы импортировать имена патчей MIDI в Pro Tools:

1 Проверьте имя устройства MIDI в окне Audio MIDI Setup (см. “Настройка Audio MIDI Setup” стр. 55).

2 Убедитесь, что выход трека MIDI корректно назначен на устройство MIDI.

3 Нажмите кнопку выбора патча у трека MIDI
Кнопка выбора патча
Кнопка выбора патча, окно Edit
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Кнопка выбора патча
Кнопка выбора патча, окно Mix
4 В диалоге выбора патча нажмите кнопку «Change»

Кнопка «Change»

Диалог выбора патча
5  В диалоге Open откройте папку /Library/Audio/MIDI Patch Names/Digidesign/<имя производителя > и выберите файл с именами патчей MIDI (.midnam) для устройства MIDI.

6 Нажмите «Open».

Диалог выбора патча будет наполнен именами патчей, и выпадающее меню Patch Name Bank появится в левом верхнем углу окна.

После того, как имена патчей импортированы в Pro Tools, они становятся доступными для данного устройства MIDI во всех сессиях. 

Чтобы очистить список имен:

В диалоге выбора патча нажмите кнопку «Clear», после чего нажмите Done.

Файлы с именами патчей MIDI (.midnam) могут быть отредактированы в любом текстовом редакторе, также можно использовать сторонние разработки для редактирования и упорядоченного хранения имен патчей, чтобы создавать собственные имена патчей.
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Приложение С: Конфигурация и эксплуатация жесткого диска

Рекомендуется начинать работу с аудио на только что отформатированном вторичном или внешнем диске. Вам также следует периодически проводить дефрагментацию диска с аудио, чтобы не страдала производительность системы.

Всегда создавайте резервную копию важных данных с вашего диска перед форматированием, поскольку оно сотрет всю информацию с диска
Избегайте записи на системный диск
Не рекомендуется вести запись на системный диск. Запись и воспроизведение с сисемного диска могут привести с уменьшению максимального количества треков или плагинов.

Поддерживаемые форматы и типы дисков
Форматы дисков
Windows Системы Windows XP должны использовать диски формата NTFS или FAT32 (предпочтительно NTFS).

Системы Windows могут также поддерживать диски Mac формата HFS+ (часто называется Mac OS Extended). Подробности см. «Pro Tools Reference Guide»

Mac Системы Mac должны использовать диски, отформатированные под файловые системы HFS или HFS+.

Диски HFS поддерживаются только как диски для переноса информации.

Производительность жесткого диска зависит от ряда факторов, включая конфигурацию системы, количество треков, частоту дискретизации сессии, плотность редактирования, количества кроссфейдов и других процессов в сессии, таких как Beat Detective.

Полный список требований к жестким дискам приведен на сайте Digidesign (www.digidesign.com).

Жесткие диски SCSI 

Digidesign рекомендует использовать сертифицированные жесткие диски SCSI с сертифицированным контроллером шины SCSI HBA или (на системах Windows) сертифицированным встроенным контроллером SCSI HBA на материнской плате.

Полная информация о количестве треков и поддерживаемом количестве и конфигурации дисков SCSI содержится на сайте Digidesign (www.digidesign.com).

Жесткие диски FireWire

Digidesign рекомендует использовать сертифицированные жесткие диски FireWire (на системах Windows) сертифицированные контроллеры FireWire.

Полная информация о количестве треков и поддерживаемом количестве и конфигурации дисков FireWire содержится на сайте Digidesign (www.digidesign.com).

Жесткие диски IDE/ATA/SATA

Сертифицированный встроенный диск IDE/ATA/SATA может быть использован как выделенный диск для аудио.

Полная информация о количестве треков на встроенных дисках содержится на сайте Digidesign (www.digidesign.com).
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Форматирование диска для аудио

Форматирование дисков в Windows
(Только для Windows)
Для оптимальной производительности диски для аудио должны быть отформатированы в FAT32 или NTFS.

Чтобы отформатировать диск:
1 В Windows Vista нажмите «Пуск».

2 Правым щелчком откройте Компьютер (Windows Vista) или Мой Компьютер и выберите «Управление»

3 В разделе «Запоминающие устройства» выберите «Управление дисками».

Окно управления дисками (Windows XP)

4 Если том “здоровый” выполните следующее:

«Здоровый» том, это том на котором созданы и отформатированы разделы.

• В окне управления дисками правой кнопкой откройте меню жесткого диска, который вы будете использовать для аудио, и выберите «Форматирование».

• В окне форматирования задайте имя тома.

• Выберите файловую систему. Для оптимальной производительности диски для аудио должны быть отформатированы в NTFS. 
• Выберите “Произвести быстрое форматирование.”

• Убедитесь, что опция «Сжатие файлов и папок» отключена

• Установите размер кластера «По умолчанию».

• Нажмите «OK».

Pro Tools поддерживает только базовые диски. Не конвертируйте тип диска в динамический
5 Если раздел кластера в томе на задан, выполните следующее:

• В окне управления дисками правой кнопкой откройте меню жесткого диска, который вы будете использовать для аудио, и выберите «Новый раздел».

• В окне мастера нового раздела нажмите «Далее».

• При запросе выберите тип раздела.

Digidesign рекомендует использовать основные разделы, а не дополнительные.

• Следуйте отображаемым на экране инструкциям, выбирая размер раздела и другие параметры раздела.

• При запросе выберите файловую систему. Для оптимальной производительности диски для аудио должны быть отформатированы в NTFS. 
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• Выберите “Произвести быстрое форматирование.”

• Убедитесь, что опция «Сжатие файлов и папок» отключена

• Установите размер кластера «По умолчанию».

• Нажмите «OK».

Pro Tools поддерживает только основные разделы, не преобразуйте их в динамические.

Форматирование дисков для аудио на Mac
(Только для Mac)

Для оптимальной производительности диски для аудио должны быть форматированы как Mac OS Extended (Journaled).

Чтобы форматировать диск:

1 Запустите приложение Disk Utility, находящееся в Applications/Utilities.
Disk Utility (Mac OS X)

2 Откройте закладку Erase.

3 Выберите диск, который вы хотите инициализировать, в колонке с левой стороны окна.

4 Выберите формат Mac OS Extended (Journaled).
Не выбирайте опцию форматирования “Case-Sensitive”. Pro Tools не будет корректно работать с дисками, форматированными с чувствительностью к регистру
5 Введите имя нового тома

6 Если вы планируете подключать диск к компьютеру с Mac OS 9, выберите опцию «Install Mac OS 9 Drivers».

7 Нажмите «Erase».

Диск с новым именем тома появится на рабочем столе.
Разделы диска
Разделы создают логические тома на физическом диске, как если бы вы создавали виртуальные жесткие диски. Разделы могут быть форматированы под соответствующую файловую систему (NTFS или FAT32 в Windows, HFS+ в Mac).

Разделы дисков FAT32 drive имеют предел в 2 терабайта (2000 гигабайт), в то время как размеры разделов в NTFS практически не имеют предела.

Windows XP позволяет видеть диск, форматированный с файловой системой NTFS или FAT32, как целый том. Отдельно взятый аудио файл Pro Tools не может быть размером более 2048 МБ.

Mac OS позволяет видеть диск больший, чем 4096 МБ как целый том. Диски должны быть инициализированы утилитой, которая опознает 2ТБ предел. Отдельно взятый аудио файл Pro Tools не может быть размером более 2048 МБ.
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Время поиска на дисках с разделами.

Время поиска реально быстрее на дисках с разделами (в предположении, что чтение и запись происходит на одном разделе), поскольку головкам приходится осуществлять поиск в пределах одного раздела, а не по всей емкости диска.

Меньший размер раздела более «быстрый», чем больший, но это происходит за счет цельности пространства хранения данных. Когда вы разделяете диск, вам требуется найти компромисс, который лучшим образом отвечает вашим требованиям к емкости и скорости доступа.

Избегайте размещения аудио файлов одной и той же сессии по разным разделам одного и того же диска, поскольку это существенно ударит по производительности.

Дефрагментация дисков для аудио

Системы Mac 

Работая с большими файлами (такими как видео) вы можете ограничить фрагментацию, сохраняя копии важных файлов на другой диск, стирая затем оригинал файла, и копирования файла обратно, вместо того, чтобы проводить дефрагментацию.

Системы Windows

Для того, чтобы производительность системы не падала, необходимо периодически выполнять дефрагменацию дисков, на которые ведётся запись. Для максимальной эффективности записи и воспроизведения, данные должны записываться на ваш жесткий диск непрерывно – минимизируя тем самым затраты на поиск необходимых фрагментов. К сожалению, компьютер не всегда может хранить звуковые файлы подобным образом, и вынужден записывать на диск там, где найдется свободное место.

При многодорожечной записи, аудио треки записываются в виде раздельных файлов, равномерно распределенных по диску. Хотя фрагментация отдельных файлов может быть нулевой, треки могут быть размещены достаточно далеко друг от друга, и чтение будет сопряжено с интенсивным поиском. Кроме того, оставшееся на диске свободное место будет дискретным, что увеличивает вероятность фрагментации последующих проходов записи.

Увеличение фрагментации увеличивает вероятность сбоев диска, что может накладываться на воспроизведение аудио и приводить к ошибкам работы.

В системах Windows, чтобы избегать фрагментации, форматируйте диски с большим размером кластеров (например 32K).

Оптимизация (дефрагментация) дисков

Чтобы предотвратить фрагментацию, вы можете оптимизировать свой диск, перераспределив файлы в непрерывном формате. Большинство программ оптимизации дают вам возможность протестировать диск, оценив процент фрагментации. Если у диска наблюдается средняя или сильная фрагментация, вам стоит оптимизировать его.

Если вы используете вашу систему для интенсивного редактирования, часто стираете аудио или файлы со своего диска, вам может понадобиться еженедельная или даже более частая 

оптимизация диска, потому что даже большой жесткий диск довольно быстро фрагментируется.

[Стр. 57]
Резервное копирование данных перед оптимизацией

Поскольку в процессе оптимизации ваши файлы будут переписываться, всегда делайте перед оптимизацией диска резервную копию данных. Вы так же должны использовать сервисные утилиты, чтобы найти и исправить все проблемы до оптимизации или переформатирования дисков. Если каталоги вашего диска как-либо повреждены до оптимизации, результатом может быть серьезная потеря данных.

Дефрагментация дисков для аудио в Windows

Чтобы дефрагментировать диск в Windows Vista:
1 Войдите в меню Windows > Панель управления.

2 Откройте «Система и ее обслуживание»

3 Откройте «Счетчики и средства производительности»

4 Откройте «Дополнительные инструменты»

5 Откройте дефрагментацию диска

6 В окне дефрагментации диска нажмите «Дефрагментировать сейчас»

Команда «Дефрагментировать сейчас» дефрагментирует все ваши жесткие диски. Это может отнять много времени, особенно в системах с несколькими дисками.

Опытные пользователи могут использовать утилиту командной строки Defrag.exe, чтобы дефрагментировать диски по отдельности. Дополнительную информацию см. в документации Windows Vista.

Чтобы дефрагментировать диск в Windows XP:

1 Правым щелчком на Мой Компьютер откройте меню и выберите «Управление»

2 В разделе «Запоминающие устройства» выберите «Дефрагментация диска»

3 В окне дефрагментации дисков, выберите диск, который хотите дефрагментировать

4 Нажмите кнопку «Дефрагментация» и следуйте инструкциям на экране.

По завершению дефрагментации закройте окно «Управление компьютером».
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Использование емкости жесткого диска

Моно аудио треки записанные с качеством 16 бит, 44.1 кГц (качество CD) требуют примерно 5МБ дискового пространства на минуту материала. Такие же треки записанные с разрешением 24 бит требуют около 7.5МБ на минуту

Стерео аудио треки записанные с качеством 16 бит, 44.1 кГц (качество CD) требуют примерно 10МБ дискового пространства на минуту материала. Такие же треки записанные с разрешением 24 бит требуют около 15МБ на минуту

В Таблице 4 приведены требуемые для определенного количества и длительности треков объемы дискового пространства, что поможет вам планировать использование емкости своего жесткого диска.

Таблица 4. Требуемое дисковое пространство для аудио треков (сессии 44.1 кГц и 48 кГц)

	Количество треков и длительность 
	 16 бит, 44,1 кГц  
	 16 бит, 48 кГц  
	 24 бит, 44,1 кГц  
	 24 бит, 48 кГц  

	 1 моно трек, 1 мин  
	 5 МБ  
	 5,5 МБ  
	 7,5 МБ  
	 8,2 МБ  

	 1 стерео трек (или два трека), 5 мин  
	 50 МБ  
	 55 МБ  
	 75 МБ  
	 83 МБ  

	 1 стерео трек (или два моно трека), 60 мин  
	 600 МБ  
	 662 МБ  
	 900 МБ  
	 991 МБ  

	 24 моно трека, 5 мин  
	 600 МБ  
	 662 МБ  
	 900 МБ  
	 991 МБ  

	 24 моно трека, 60 мин  
	 7 ГБ  
	 7,8 ГБ  
	 10,5 ГБ  
	 11,6 ГБ  

	 32 моно трека, 5 мин  
	 800 МБ  
	 883 МБ  
	 1,2 ГБ  
	 1,3 ГБ  

	 32 моно трека, 60 мин  
	 9,4 ГБ  
	 10,4 ГБ  
	 14 ГБ  
	 15,4 ГБ  
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Приложение D. Устранение проблем

Резервное копирование материала

Настоятельно рекомендуется регулярно проводить резервное копирование записанного материала, особенно перед внесением изменений в конфигурацию системы.

Резервное копирование данных сессии

Почаще проводите резервное копирование своих сессий и аудио. Есть широкий выбор носителей, которые пригодны для резервного копирования проектов различного объема, включая дополнительные жесткие диски, пишущие CD/DVD приводы, автоматические ленточные архиваторы и оптические диски высокой емкости.

Оптимальный способ копирования сессии целиком – использование команды Save Copy In. Эта команда позволяет вам сохранить файл сессии и все связанные с ним файлы в новом месте.

Вы также можете использовать функцию Auto Save Backup, (в настройке Operation Preferences), чтобы в Pro Tools происходило автоматическое копирование файла сессии в процессе работы
Резервное копирование конфигурации вашей системы
После настройки своей системы и Pro Tools вам следует сохранить образ своей системы при помощи утилиты резервного копирования Norton Ghost (Windows) или Bombich Carbon Copy Cloner (Mac). Таким образом вы сможете быстро восстановить конфигурацию и настройки системы, в случае возникновения каких-то проблем.By doing this, you can quickly restore.

Распространенные проблемы

Pro Tools не запускается

Проблема
Когда вы делаете двойной щелчок на приложении Pro Tools или файле сессии Pro Tools, Pro Tools не запускается или выдает сообщение об ошибке.

Возможные решения
· Убедитесь, что ваш компьютер имеет требуемое для работы Pro Tools количество оперативной. См. сайт Digidesign (www.digidesign.com).

· Попробуйте полный перезапуск. Выключите аудиоинтерфейсы, компьютерную периферию и ваш компьютер. Затем включите все это снова в правильной последовательности.

· Если вы пытались запустить Pro Tools двойным щелчком на файле сессии Pro Tools, попробуйте следующее:
• Закройте все сообщения об ошибках.
• Двойным щелчком запустите приложение Pro Tools.
• В Pro Tools, через меню File > Open Session откройте сессию.

· Переустановите Pro Tools с установочного диска Pro Tools.
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Аудиоинтерфейс не распознается

Проблема
Когда вы запускаете Pro Tools, программа не распознает аудиоинтерфейс или подключенный аудиоинтерфейс не включается.

Возможные решения
· Выключите компьютер и проверьте, что ваши кабели надежно и правильно соединяют компьютер и аудиоинтерфейс. 

· Проверьте правильность настроек диалога Hardware Setup.

· Попробуйте отсоединить кабель USB от порта USB на Mbox 2 Micro и снова подключить его. Если индикатор USB по-прежнему не горит, выключите компьютер, отсоедините Mbox 2 Micro и перезапустите компьютер. После полной перезагрузки компьютера снова подключите Mbox 2 Micro.

Вопросы производительности
Есть некоторые факторы, которые могут существенно снизить производительность Pro Tools. Они включают в себя:

Сетевые подключения. Закройте все сетевые подключения, если только вы не используете их для обмена аудио данными по сети.

Фоновые приложения. Любые программные утилиты, выполняемые в фоновом режиме или обращающиеся к диску, такие как защита от вирусов, оптимизация диска, защита файлов, должны быть удалены или отключены.

Заставки Экрана Заставки экрана должны быть полностью отключены перед запуском Pro Tools.

Энергосбережение Некоторые функции автоматического энергосбережения, например те, что замедляют вращение системного жесткого диска могут повлиять на производительность Pro Tools. Эти опции должны быть отключены.
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Перед тем как обратиться в службу поддержки Digidesign
Зарегистрируйте свою систему

Зарегистрируйте свою систему немедленно по прочтении регистрационной карты Digidesign, прилагаемой ко всем системам Pro Tools. Регистрация покупки – единственный способ получить право на техническое сопровождение и предложения по обновлению системы. Регистрация – один из важнейших шагов, которые должен выполнить новый пользователь.

Используйте ресурсы Digidesign

Помимо печатных и электронных версий руководств Pro Tools ваша система включает следующие источники информации:

Файлы Read Me Содержат самую свежую информацию и известные проблемы касательно программных и аппаратных конфигураций Pro Tools.

Файлы Read Me размещаются в папке Documentation во время установки Pro Tools.

База знаний Это база данных, посвященная распространенным проблемам, ошибкам ядра DAE и решениям по их устранениям, основанных на новейшей информации от службы технической поддержки Digidesign. Эта база данных размещается я в папке Digidesign во время установки Pro Tools. База знаний также доступна на сайте Digidesign (www.digidesign.com).

Сайт (www.digidesign.com) Это ваш лучший ресурс Интернет, помогающий получить максимум от вашей системы Pro Tools..

Сбор важной информации
Digidesign стремится помочь вам решить проблемы настолько быстро и эффективно, насколько возможно. Если в момент обращения в службу технической поддержки у вас на руках будет следующая информация, это поможет ей быстрее диагностировать вашу проблему. Потратьте насколько минут на сбор следующей базовой информации:

Информация о системе

Компьютер

• Производитель, модель, частота процессора

• Количество оперативной памяти

• Операционная система (версия Windows или Mac OS)

• Любые драйверы, дисковые утилиты и другие системные приложения, которые могут быть установлены
Оборудование Digidesign

• Тип карт, интрефейсов и периферийных устройств
Жесткие диски

• Производитель, модель

• Объем диска (ГБ)

• Скорость вращения (об/мин)

• Тип диска (SCSI, FireWire, IDE/ATA)

• Утилита, использованная для форматирования диска

• Количество и размер разделов на диске

ПО Digidesign

• Версия Pro Tools

• Версии плагинов
• Другое ПО Digidesign

• Дополнительные плагины от партнеров Digidesign по разработке
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Другое оборудование

Обратитесь к документации производителей за параметрами устройств.

Самые распространенные аппаратные расширения включают:

• Карты 1394 (FireWire) для систем Windows (производитель, модель)

• Карты захвата видео (производитель, модель)
Чтобы проверить сертификацию своего оборудования на совместимость с системами Pro Tools, обратитесь с свежей информации о совместимости на сайте Digidesign (www.digidesign.com).

Другое ПО
Если вы используете другие аудио или видео приложения, обратитесь к документации разработчика за деталями.

Отметьте работу другого ПО в момент возникновения проблемы.

Диагностическая информация

Отметьте любые ошибки ядра DAE и коды других ошибок, сообщения о которых вы получили.

Кроме того, проверьте возможность воспроизвести проблему в различных условиях, например, с другой сессией или после изменения настроек (таких как Hardware Buffer Size).













